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Chapter 1 — General Information

1-1 Introduction

The Spectrum Master MS2711E User Guide is part of a set of manuals that cover all of the 

instrument functions and their use. This manual covers the instrument overview, system 

functions, and other common features, along with a brief guide to basic measurement 

concepts and setups. Most instrument operations and modes are covered in specific 

measurement guides as listed below.

Additional Documentation

Read the Handheld Instruments Product Information, Compliance, and Safety Guide 

(PN: 10100-00065) for important safety, legal, and regulatory notices before operating the 

equipment. For additional information and literature covering your product, visit the product 

page of your instrument and select the Library tab:

� http://www.anritsu.com/en-US/test-measurement/products/ms2711e 

Contacting Anritsu for Sales and Service

To contact Anritsu, please visit the following URL and select the services in your region:

http://www.anritsu.com/contact-us.

Document Part Number Description (Required Option)

10100-00065 Important Product Information, Compliance and Safety Notices

10580-00244

Spectrum Analyzer Measurement Guide

Spectrum Analyzer

Preamplifier (Option 8)

Interference Analyzer (Option 25)

Channel Scanner (Option 27)

EMF Measurements (Option 444)

AM/FM/PM Analyzer (Option 509)

10580-00240

Power Meter Measurement Guide

High-Accuracy Power Meter (Option 19)

Power Meter (Option 29)

11410-00597
Spectrum Master Technical Data Sheet

Performance Specifications

10580-00339

E-Series Tracking Generator 

Measurement Guide

Tracking Generator (Option 20)

10580-00256
Spectrum Master Programming Manual

SCPI Programming Instruction

10580-00254
Spectrum Master Maintenance Manual

Maintenance Manual
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1-2 Instrument Description

The Spectrum Master MS2711E is an integrated multi-functional test instrument that 

eliminates the need to carry and learn multiple test sets. The Spectrum Master can be 

configured to include: spectrum analyzer, interference analyzer with interference mapping 

capabilities, tracking generator, channel scanner, power meter, high accuracy power meter, 

and an AM/FM/PM analyzer. A GPS receiver can be added to the MS2711E Spectrum Master 

model.

The bright 8.4 inch TFT color display provides easy viewing in a variety of lighting conditions. 

The MS2711E model is equipped with a Li-Ion battery delivering more than three hours of 

battery life. The combination of a touch screen and keypad enables users to navigate menus 

with the touch screen and enter numbers with the keypad.

The internal memory is large enough to store approximately 2,000 traces or setups. 

Measurements and setups can also be stored in a USB flash drive or transferred to a PC using 

the included USB cable. 

Available Options

Available options for the Spectrum Master MS2711E model is shown in Table 1-1.

1. Requires Option 31.

Note

Not all USB drives are compatible with the instrument. Many drives come with a 

second partition that contains proprietary firmware. This partition must be 

removed. Only one partition is allowed. Refer to the individual manufacturer for 

instructions on how to remove it. Some drives can be made to work by reformatting 

them using the FAT32 format.

Table 1-1. Available Options

Option Number Description

MS2711E-0031 GPS Receiver (Requires GPS Antenna)

MS2711E-0019 High-Accuracy Power Meter (Requires External Power Sensor)

MS2711E-0029 Power Meter

MS2711E-0020 Tracking Generator

MS2711E-0008 Preamplifier

MS2711E-0025 Interference Analyzer(1)

MS2711E-0027 Channel Scanner

MS2711E-0509 AM/FM/PM Analyzer

MS2711E-0098 Standard Calibration (ANSI 2540-1-1994)

MS2711E-0099 Premium Calibration to Z540 plus test data

MS2711E-0444 EMF Measurement (Requires Anritsu Isotropic Antenna)
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1-3 Instrument Care and Preventive Maintenance

Site Master care and preventive maintenance consists of cleaning the unit and inspecting and 

cleaning the RF connectors on the instrument and all accessories. Clean the Site Master with 

a soft, lint-free cloth dampened with water or water and a mild cleaning solution.

Connector Care

Clean the RF connectors and center pins with a cotton swab dampened with denatured 

alcohol. Visually inspect the connectors. The fingers of the N(f) connectors and the pins of the 

N(m) connectors should be unbroken and uniform in appearance. If you are unsure whether 

the connectors are undamaged, gauge the connectors to confirm that the dimensions are 

correct. Visually inspect the test port cable(s). The test port cable should be uniform in 

appearance, and not stretched, kinked, dented, or broken.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 

Type-N connectors. The recommended torque is 12 lbf·in to 15 lbf·in (1.36 N·m to 1.70 N·m). 

Inadequate torque settings can affect measurement accuracy. Over-tightening connectors can 

damage the cable, the connector, the instrument, or all of these items.

Visually inspect connectors for general wear, cleanliness, and for damage such as bent pins or 

connector rings. Repair or replace damaged connectors immediately. Dirty connectors can 

limit the accuracy of your measurements. Damaged connectors can harm the instrument. 

Connection of cables carrying an electrostatic potential, excess power, or excess voltage can 

damage the connector, the instrument, or both.

Connecting Procedure

1. Carefully align the connectors. The male connector center pin must slip concentrically 

into the contact fingers of the female connector.

2. Push connectors straight together. Do not twist or screw them together. A slight 

resistance can usually be felt as the center conductors mate.

3. To tighten, turn the connector nut, not the connector body. Major damage can occur to 

the center conductor and to the outer conductor if the connector body is twisted.

4. If you use a torque wrench, initially tighten by hand so that approximately 1/8 turn or 

45 degrees of rotation remains for the final tightening with the torque wrench.

Relieve any side pressure on the connection (such as from long or heavy cables) in order 

to assure consistent torque. Use an open-end wrench to keep the connector body from 

turning while tightening with the torque wrench.

Do not over-torque the connector.

Disconnecting Procedure 

1. If a wrench is needed, use an open-end wrench to keep the connector body from turning 

while loosening with a second wrench.

2. Complete the disconnection by hand, turning only the connector nut.

3. Pull the connectors straight apart without twisting or bending.

Caution To avoid damaging the display or case, do not use solvents or abrasive cleaners.
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ESD Caution

The Spectrum Master, like other high performance instruments, is susceptible to electrostatic 

discharge (ESD) damage. Coaxial cables and antennas often build up a static charge, which 

(if allowed to discharge by connecting directly to the Spectrum Master without discharging 

the static charge) may damage the Spectrum Master input circuitry. Spectrum Master 

operators must be aware of the potential for ESD damage and take all necessary precautions. 

Operators should exercise practices outlined within industry standards such as JEDEC-625 

(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, 

equipment, and practices. Because these apply to the Spectrum Master, it is recommended 

that any static charges that may be present be dissipated before connecting coaxial cables or 

antennas to the Spectrum Master. This may be as simple as temporarily attaching a short or 

load device to the cable or antenna prior to attaching to the Spectrum Master. It is important 

to remember that the operator may also carry a static charge that can cause damage. 

Following the practices outlined in the above standards will ensure a safe environment for 

both personnel and equipment. 
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Battery Replacement

The battery can be replaced without the use of tools. The battery compartment is located 

on the lower left side of the instrument (when you are facing the measurement display). 

To remove the battery:

1. Slide the catch toward the bottom of the instrument.

2. Pull the top of the door away from the unit.

3. Lift out the battery door.

4. Remove the battery pack from the instrument by grabbing the battery lanyard and 

pulling out.

Replacement is the opposite of removal. The battery key side (slot below the contacts) should 

be facing the front of the unit and slide in first. 

Note

When inserting the battery, the battery label should face the back of the instrument 

and the guide slot on the battery should be below the contacts. If the battery door 

does not latch closed, the battery may be inserted incorrectly.

Figure 1-1. Battery Compartment Door
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The battery that is supplied with the Spectrum Master may need charging before use. The 

battery can be charged while it is installed in the Spectrum Master by using either the 

AC-DC Adapter or the DC adapter, or outside the Spectrum Master with the optional 

Dual Battery Charger. Refer to “Battery Symbols” on page 2-9 for a description of battery 

symbols.

1-4 Calibration and Verification

Anritsu recommends an annual calibration and performance verification of the 

Spectrum Master by a local Anritsu service center. The Spectrum Master is self-calibrating 

and there are no field-adjustable components. Contact information for Anritsu Service 

Centers is available at http://www.anritsu.com/contact-us.

Note

Use only Anritsu Company approved batteries, adapters, and chargers with this 

instrument. Anritsu Company recommends removing the battery for long-term 

storage of the instrument.

Caution

When using the Automotive Cigarette Lighter Adapter, always verify that the 

supply is rated for a minimum of 60 Watts @ 12 VDC, and that the socket is clear 

of any dirt or debris. If the adapter plug becomes hot to the touch during operation, 

then discontinue use immediately.
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1-5 Secure Environment Workplace

This section details the types of memory in the Spectrum Master, how to delete stored user 

files in internal memory, and recommended usage in a secure environment workplace.

Spectrum Master Memory Types: The instrument contains non-volatile disk-on-a-chip 

memory, EEPROM, and volatile DRAM memory. The instrument is also supplied with an 

external USB flash drive. The instrument does not have a hard disk drive or any other type of 

volatile or non-volatile memory.

Disk-On-A-Chip (DOC): DOC is used for storage of instrument firmware, factory calibration 

information, user measurements, setups, and .jpg screen images. User information stored on 

the DOC is erased by the master reset process described below.

EEPROM: This memory stores the model number, serial number, and calibration data for the 

instrument. Also stored here are the user-set operating parameters such as frequency range. 

During the master reset process all operating parameter stored in the EEPROM are set to 

standard factory default values.

RAM Memory: This is volatile memory used to store parameters needed for the normal 

operation of the instrument along with current measurements. This memory is reset 

whenever the instrument is restarted.

External USB Flash Drive (not included with the instrument): This memory may be selected 

as the destination for saved measurements and setups for the instrument. The user can also 

copy the contents of the internal disk-on-chip memory to the external flash memory for 

storage or data transfer. The external Flash USB can be reformatted or sanitized using 

software on a PC. 

Refer to the Chapter 4, “File Management” for additional information on saving and copying 

files to the USB flash drive.

Erase All User Files in Internal Memory

Perform a Master Reset:

1. Turn the instrument on.

2. Press the Shift button then the System (8) button.

3. Press the System Options submenu key.

4. Press the Reset key, then the Master Reset key.

5. A dialog box will be displayed on the screen warning that all settings will be returned to 

factory default values and all user files will be deleted. This deletion is a standard file 

delete and does not involve overwriting exiting information.

6. Press the ENTER button to complete the master reset.

7. The instrument will reboot and the reset is complete.

Recommended Usage in a Secure Environment

Set the Spectrum Master to save files to the external USB Flash drive:

1. Attach the external Flash drive and turn the instrument on.

2. Press the Shift button then the File (7) button.

3. Press the Save submenu key.
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4. Press the Change Save Location submenu key, then select the USB drive with the 

rotary knob, Up/Down arrow keys, or the touchscreen.

5. Press the Set Location submenu key.

The external USB drive is now the default location for saving files.

Note

Not all USB drives are compatible with the instrument. Many drives come with a 

second partition that contains proprietary firmware. This partition must be 

removed. Only one partition is allowed. Refer to the individual manufacturer for 

instructions on how to remove it. Some drives can be made to work by reformatting 

them using the FAT32 format.
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Chapter 2 — Instrument Overview 

2-1 Introduction

This chapter provides a brief overview of the Anritsu Spectrum Master. The intent of this 

chapter is to acquaint the user with the instrument. For detailed measurement information, 

refer to a specific measurement guide listed in Appendix A, “Measurement Guides”. 

2-2 Turning On the Spectrum Master

The Anritsu Spectrum Master is capable of approximately three hours of continuous 

operation from a fully charged, field-replaceable battery (see Section “Battery Replacement” 

on page 1-5). The Spectrum Master can also be operated from a 12 Vdc source (which will also 

simultaneously charge the battery). This can be achieved with either the Anritsu AC-DC 

Adapter or the Automotive Cigarette Lighter Adapter. Both items are included with the 

Spectrum Master. 

To turn on the Spectrum Master, press the green On/Off button on the front panel 

(Figure 2-1) 

The Spectrum Master takes approximately sixty seconds to complete power warm-up and 

to load the application software. At completion, the instrument is ready for use. 

Caution

When using the Automotive Cigarette Lighter Adapter, always verify that the 

supply is rated for a minimum of 60 Watts @ 12 VDC, and that the socket is clear 

of any dirt or debris. If the adapter plug becomes hot to the touch during operation, 

discontinue use immediately. 

Figure 2-1. Spectrum Master Overview
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2-3 Front Panel Overview 

The Spectrum Master menu-driven interface is easy to use and requires little training. The 

Spectrum Master uses a touch screen and keypad for data input. The five bottom menu keys 

and eight submenu keys on the right side are touch screen keys. The menu and submenu keys 

will vary depending upon the selected mode of operation, see “Mode Selector Menu” 

on page 2-12.

Numeric keys 1 through 9 are dual purpose, depending upon the current mode of operation. 

The dual-purpose keys are labeled with a number on the key itself and the alternate function 

is printed in blue above each of the keys. Use the blue Shift key to access the functions printed 

on the panel. The Escape key, used for aborting data entry, is the oval button located above 

numeric key 9. The rotary knob, the four arrow keys, and the keypad can be used to change 

the value of an active parameter. 

The Menu key provides graphical icons of all the installed measurement modes and user 

defined short-cuts (see “Menu Key” on page 2-3). The locations of the keys are shown in 

Figure 2-1. 

Note
Keep the fan inlet and exhaust ports clear of obstructions at all times for proper 

ventilation and cooling of the instrument.
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Front Panel Keys

Menu Key

Press the Menu key to display a grid of shortcut icons for installed measurement modes and 

user selected menus and setup files. 

Figure 2-2 shows the Menu key screen with shortcut icons for the installed measurement 

modes. Touch one of the icons in the top two rows to change modes. These icons are 

preinstalled and can not be moved or deleted. 

Figure 2-3 shows the Menu key screen with shortcut icons for the installed measurement 

modes and four rows of user-defined shortcuts to menus and setup files. 

Figure 2-2. Menu Key Screen, Icons for Installed Measurements and Shortcuts

Note
The display of the Menu screen will vary depending on Spectrum Master model, 

firmware version, and installed options.
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Press and hold down any key for a few seconds to add a shortcut to this screen.To shortcut 

setup files (.stp), open the recall menu and hold down on the file name for several seconds. 

Then select the location for the shortcut. 

User-defined shortcuts will stay in memory until deleted. To delete or move a shortcut button, 

press the Menu key then press and hold the shortcut for approximately 3 seconds. The 

Customize Button dialog box will open to allow a button to be deleted or moved. Press Esc to 

exit the Menu shortcut display. 

Help for the Menu shortcut screen is available by pressing the icon in the lower-right corner 

of the display.

Esc Key

Press this key to cancel any setting that is currently being made. 

Enter Key

Press this key to finalize data input or select a highlighted item from a list.

Arrow Keys

The four arrow keys (around the Enter key) are used to scroll up, down, left, or right. The 

arrow keys can often be used to change a value or to change a selection from a list. This 

function is similar to the function of the rotary knob. The arrow keys are also used to move 

markers. 

Figure 2-3. Menu Key Screen

Note
The Factory Default reset will delete all user created shortcut icons from the Menu 

screen. Refer to the “Reset Menu” on page 5-7 for additional information.
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Shift Key 

Pressing the Shift key and then a number key executes the function that is indicated in blue 

text above the number key. When the Shift key is active, its icon is displayed at the top-right 

of the measurement display area by the battery charge indicator. 

Number Keypad 

The Number keypad has two functions: The primary function is number entry. The secondary 

function of the number keypad is to list various menus. See “Keypad Menu Keys (1 to 9)” 

on page 2-5.

Rotary Knob 

Turning the rotary knob changes numerical values, scrolls through selectable items from a 

list, and moves markers. Values or items may be within a dialog box or an edit window. 

Touch Screen Keys

Main Menu Touch Screen Keys 

These five main menu keys are horizontally arranged along the lower edge of the touch 

screen. The main menu key functions change to match specific instrument Mode settings. 

The main menu keys generate function-specific submenus. The various measurement modes 

are selected by pressing the Shift key and then the Mode (9) key. Descriptions of the various 

measurement modes can be found in the applicable Measurement Guides listed in 

Appendix A, “Measurement Guides”.

Submenu Touch Screen Keys

These submenu keys are arranged along the right-hand edge of the touch screen. The 

submenu labels change as instrument measurement settings change. The current submenu 

title is shown at the top of the submenu key block.

Keypad Menu Keys (1 to 9)

Pressing the Shift key and then a number key selects the menu function that is printed in 

blue characters above the number key. See Figure 2-1 on page 2-1.

Not all Secondary Function Menus are active in various measurement modes. If any one of 

these menus is available in a specific instrument mode of operation, then it can be called from 

the number keypad. It may also be available from a main menu key or a submenu key. 

The Preset Menu (1) and System Menu (8) are described in Chapter 5, “System Operations ”. 

The Sweep Menu (3), Measure Menu (4), Trace Menu (5), and Limit Menu (6) vary depending 

on measurement mode, see the Measurement Guides listed in Appendix A for information. 

The File Menu (7) is described in Chapter 4, “File Management”. The Mode Menu (9) is 

described in “Mode Selector Menu” on page 2-12. 

Figure 2-4. Shift Key Icon

Note
Available measurement modes are based on model and options purchased. Refer 

to Table 1-1 for additional information.
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LED Indicators

Power LED

The Power LED is located to the left of the On/Off key. The LED is solid green when the unit 

is on and slowly blinks when the unit is off but has external power.

Charge LED

The Charge LED is located to the right of the On/Off key. The LED slowly blinks when the 

battery is charging and is solid green when the battery is fully charged.

2-4 Display Overview 

Figure 2-5 illustrates some of the key information areas of the Spectrum Master in Spectrum 

Analyzer mode. For detailed information, refer to the Measurement Guides listed in 

Appendix A, “Measurement Guides”.  

Figure 2-5. Spectrum Analyzer Display

Note
Many of measurement settings are used as touch screen shortcuts. Use the touch 

screen to select a measurement setting to edit.
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In addition to the default color display, Spectrum Master offers the following display settings 

for the Spectrum Analyzer, Interference Analyzer, Channel Scanner, AM/FM/PM Analyzer, 

Power Meter, and High Accuracy Power Meter modes:

Black & White for printing and viewing in broad daylight conditions

Night Vision optimized for night-time viewing

High Contrast for other challenging viewing conditions 

Figure 2-6. Spectrum Master Display Settings

Default Colors Black & White

High ContrastNight Vision
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2-5 Test Panel Connector Overview

Test panel connector for the Spectrum Master is shown in Figure 2-7. 

External Power

The external power connector is used to power the unit and for battery charging. Input is 

12 VDC to 15 VDC at up to 5.0 A. The green flashing Power LED near the power switch 

indicates that the instrument has external power. 

USB Interface – Type A

The Spectrum Master has two Type A USB connectors that accept USB Flash Memory 

devices for storing measurements, setups data, and screen images.

USB Interface – Mini-B

The USB 2.0 Mini-B connector can be used to connect the Spectrum Master directly to a PC. 

The first time the Spectrum Master is connected to a PC, the normal USB device detection by 

the computer operating system will take place. 

Figure 2-7. Spectrum Master Test Panel Connector

Warning

When using the AC-DC Adapter, always use a three-wire power cable that is 

connected to a three-wire power line outlet. If power is supplied without grounding 

the equipment in this manner, then the user is at risk of receiving a severe or fatal 

electric shock.

Note
For proper detection, the applicable Anritsu Software Tool should be installed on 

the PC prior to connecting the Spectrum Master to the USB port.

Headset JackGenerator/RF Out

(Option 20)

External 

Power

GPS

USB Mini-B

Analyzer/RF In
External

Reference
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Trigger

USB Type A
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Headset Jack

The headset jack provides audio output from the built-in AM/FM/SSB demodulator for testing 

and troubleshooting wireless communication systems. The jack accepts a 2.5 mm 3-wire 

miniature phone plug such as those commonly used with cellular telephones.

External Trigger In

A TTL signal that is applied to the External Trigger female BNC input connector causes a 

single sweep to occur. In the Spectrum Analyzer mode, it is used in zero span, and triggering 

occurs on the rising edge of the signal. After the sweep is complete, the resultant trace is 

displayed until the next trigger signal arrives. 

Analyzer/RF In

50 Ω Type-N female connector. Maximum input is +30 dBm at 50 VDC.

Generator/RF Out (Option 0020)

RF output, 50 Ω impedance, for tracking generator (Option 20). Maximum input is +23 dBm 

at ±50 VDC.

GPS Antenna Connector (Option 0031)

The GPS antenna connection on the Spectrum Master is type SMA-female. GPS function is 

described in Chapter 6, “GPS (Option 31)”.

2-6 Symbols and Indicators

The following symbols and indicators indicate the instrument status or condition on the 

display.

Battery Symbols

The battery symbol above the display indicates the charge remaining in the battery. The 

colored section inside the symbol changes size and color with the charge level.

Green with Black Plug body: Battery is fully charged and external power is applied

Green: Battery is 30% to 100% charged

Yellow: Battery is 10% to 30% charged

Red: Battery 0% to 10% charged

Lightning Bolt: Battery is being charged (any color symbol)

Detailed battery information is also available in the Status dialog box (System > Status).

Figure 2-8. Battery Status
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When either the AC-DC Adapter or the Automotive Cigarette Lighter Adapter is connected, 

the battery automatically receives a charge, and the battery symbol with the lightning bolt is 

displayed (Figure 2-9). 

The green Charge LED flashes when the battery is charging, and remains on steady when the 

battery is fully charged. 

When operating from external power without a battery installed, the battery symbol is 

replaced by a red plug body (Figure 2-10). 

Additional Symbols

Single Sweep

Single Sweep is selected. Press Continuous in the Sweep menu to resume continuous sweeping.

Floppy Icon

Shortcut to the Save submenu. Touch the icon to open the touch screen keyboard for saving 

measurements, setups, or screen displays.

Figure 2-9. Battery Charging Icon

Caution Use only Anritsu-approved batteries, adapters, and chargers with this instrument.

Figure 2-10. Battery Not Installed
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2-7 Data Entry

Numeric Values

Numeric values are changed using the rotary knob, arrow keys, or the keypad. Pressing one 

of the main menu keys will display a list of submenus on the right side of the touch screen. 

When the value on a submenu key is displayed in red, it is ready for changing. When using 

the rotary knob or arrow keys the changing value is shown on the submenu and in red on the 

graticule. When using the keypad, the new value is shown in red on the graticule and the 

submenu changes to Units. Selecting a unit for the new value completes the entry.

Parameter Setting

Pop-up list boxes or edit boxes are used to provide selection lists and selection editors. Scroll 

through a list of items or parameters with the arrow keys, the rotary knob, or the touch 

screen. These list boxes and edit boxes frequently display a range of possible values or limits 

for possible values.

Finalize the input by pressing the Enter key. At any time before finalizing the input, press the 

escape (Esc) key to abort the change and retain the previously existing setting.

Some parameters (such as for antennas or couplers) can be added to list boxes by creating 

them and importing them using Master Software Tools.

Text Entry 

When entering text, as when saving a measurement, the touch screen keyboard is displayed 

(Figure 2-11). Characters are entered directly with the touch screen keyboard. The keypad 

can be used for numeric entry. The left and right arrow keys will scroll the cursor through the 

filename. See “Save Menu” on page 4-8 for additional information.

Figure 2-11. Touch Screen Keyboard
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2-8 Mode Selector Menu 

To access the functions under the Mode menu, select the Shift key, then the Mode (9) key. Use 

the directional arrow keys, the rotary knob, or the touch screen to highlight the selection, and 

press the Enter key to select. The list of modes that appear in this menu will vary depending 

upon the options that are installed and activated in the instrument. Figure 2-12 is an 

example of the Mode menu. Your instrument may not show the same list. The current mode is 

displayed below the battery symbol. 

The Menu key is another option to quickly change measurement modes. Press the Menu key 

then select one of the Measurement icons in the top two rows (Figure 2-2 on page 2-3). 

2-9 Soft Carrying Case

The Spectrum Master can be operated while in the soft carrying case. On the back of the case 

is a large storage pouch for accessories and supplies.

To install the instrument into the soft carrying case:

1. The front panel of the case is secured with hook-and-loop fasteners. Fully close the front 

panel of the case. When closed, the front panel supports the shape of the case while you 

are inserting the Spectrum Master.

2. Place the soft carrying case face down on a stable surface, with the front panel fully 

closed and laying flat.

3. Open the zippered back of the case.

Figure 2-12. Mode Selector Menu

Note The display of the Mode Selector will vary depending on the installed options.

Note

The soft case has two zippers near the back. The zipper closer to the front of the 

case opens to install and remove the instrument. The zipper closer to the back of 

the case opens an adjustable support panel that can be used to provide support for 

improved stability and air flow while the instrument is in the case. This support 

panel also contains the storage pouch.
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4. Insert the instrument face down into the case, take care that the connectors are 

properly situated in the case top opening. You may find it easier to insert the 

connectors first, then pull the corners over the bottom of the Spectrum Master.

5. Close the back panel and secure with the zipper to secure the Spectrum Master.

The soft carrying case includes a detachable shoulder strap, which can be connected to the 

D-rings of the case.

Figure 2-13. Instrument Inserted into the Soft Carrying Case

Caution
The soft case has panel openings for the fan inlet and exhaust ports. Do not block 

the air flow through the panels when the unit is operating.
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2-10 Tilt Bail Stand

A Tilt Bail is attached to the back of the Spectrum Master for desktop operation. The tilt bail 

provides two settings of backward tilt for improved stability. To deploy the tilt bail, pull the 

bottom of the tilt bail away from the back of the instrument. To store the tilt bail, push the 

bottom of the bail towards the back of the instrument until it attaches to the Spectrum 

Master. 

Note
Do not use the tilt bail while the instrument is in the soft case. The soft case has an 

adjustable support panel in the back zipper.

Figure 2-14. Tilt Bail Extended
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Chapter 3 — Quick Start Guide

3-1 Introduction

This chapter provides a brief overview of basic measurement setups. For detailed 

measurement information, refer to a specific measurement guide listed in 

Appendix A, “Measurement Guides”. This chapter provides quick start measurement 

information for the Spectrum Analyzer mode:

3-2 Measurement Mode Selection

Press the Menu key and use the touch screen to select the appropriate measurement icon.

Figure 3-1.  Menu Screen with Icons for Installed Measurement Modes

Note The display of the instrument will vary based on installed options and firmware.
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3-3 Spectrum Analyzer

Set the instrument to Spectrum Analyzer mode as described in Section 3-2 “Measurement 

Mode Selection” on page 3-1. 

Set the Frequency

Set Start and Stop Frequencies

1. Press the Freq main menu key. 

2. Press the Start Freq submenu key.

3. Enter the desired start frequency using the keypad, the arrow keys, or the rotary knob. 

When entering a frequency using the keypad, the submenu key labels change to GHz, 

MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same 

affect as pressing the MHz submenu key.

4. Press the Stop Freq submenu key.

5. Enter the desired stop frequency.

Set the Center Frequency

1. Press the Freq main menu key.

2. Press the Center Freq submenu key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary knob. 

When entering a frequency using the keypad, the submenu key labels change to GHz, 

MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same 

affect as pressing the MHz submenu key.

The center frequency and span is shown at the bottom of the screen.

Select a Signal Standard

1. Press the Freq main menu key.

2. Press the Signal Standard submenu key. The Signal Standards dialog box opens.

3. Highlight a signal standard and press Enter to select.

4. Press the Channel submenu key to change the channel value in the Channel Editor.

The signal standard is shown in yellow at the top of the screen.

Set the Frequency Offset

1. Press the Freq main menu key.

2. Press the Step Size & Other submenu key. 

3. Press the Freq Offset submenu key and enter the desired frequency offset using the 

keypad, the arrow keys, or the rotary knob. When entering a frequency using the 

keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the 

appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz 

submenu key.

4. Offset will be displayed at the bottom of the screen. The Center Freq, Start Freq, and 

Stop Freq keys will also indicate that a frequency offset has been turned on.
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5. Set the Freq Offset to 0 Hz to remove the frequency offset.

Set the Measurement Frequency Bandwidth

1. Press the BW main menu key to display the BW menu.

� Press the RBW and/or the VBW submenu key to manually change the values.

� Set RBW and VBW automatically by pressing the Auto RBW submenu key or the 
Auto VBW submenu key.

2. Press the RBW/VBW submenu key to change the resolution bandwidth and video 

bandwidth ratio.

3. Press the Span/RBW submenu key to change the span width to resolution bandwidth 

ratio.

Set the Amplitude

Press the Amplitude main menu key to display the Amplitude menu.

Set Amplitude Reference Level and Scale

1. Press the Reference Level submenu key and use the arrow keys, rotary knob, or the 

keypad to change the reference level. Press Enter to set the reference level value.

2. Press the Scale submenu key and use the arrow keys, rotary knob, or the keypad to 

enter the desired scale. Press Enter to set the scale value.

Set Amplitude Range and Scale

1. Press the Auto Atten submenu key to set an optimal reference level based on the 

measured signal.

2. Press the Scale submenu key.

3. Enter the desired scale units by using the keypad, the arrow keys, or the rotary knob. 

Press Enter to set. The y-axis scale is automatically renumbered.

Note

The Freq Offset will affect the displayed values of frequencies, Markers and Limits.  

The currently frequency offset value is displayed on the Freq Offset submenu key, 

located under the Freq main menu > Step Size & Offset submenu. 
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Reference Level Offset for External Loss or External Gain

To obtain accurate measurements, compensate for any external attenuation or gain by using 

the RL Offset submenu. The compensation factor is in dB. External attenuation can be 

created by using an external cable or an external high power attenuator, external gain is 

typically from an amplifier.  

To adjust the reference level for either gain or loss, press the RL Offset submenu key and 

enter a positive dB value and then press the appropriate submenu key (dB External Gain or 

dB External Loss). The new RL Offset value will be displayed on the instrument and reference 

level is adjusted.

Set the Span

1. Press the Span main menu key or the Freq main menu key followed by the 

Span submenu key.

2. To select full span, press the Full Span submenu key. Selecting full span overrides any 

previously set Start and Stop frequencies.

3. For a single frequency measurement, press the Zero Span submenu key.

Single Limit Line

Press the Limit menu key to display the Limit menu.

1. Press the Limit (Upper / Lower) submenu key to select the desired limit line, 

Upper or Lower.

2. Activate the selected limit line by pressing the On Off submenu key so that On is 

underlined.

3. Press the Limit Move submenu key to display the Limit Move menu. Press the first 

Move Limit submenu key and use the arrows keys, rotary knob, or keypad to change the 

dBm level of the limit line.

4. Press the Back submenu key to return to the Limit menu.

5. If necessary, press the Set Default Limit submenu key to redraw the limit line in view.

Note

To quickly move the span value up or down, press the Span Up 1-2-5 or Span 

Down 1-2-5 submenu keys These keys facilitate a zoom-in, zoom-out feature in a 

1-2-5 sequence.
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Create a Limit Envelope

1. Press Shift then Limit (6) to open the Limit menu.

2. Select Limit Envelope.

3. Press the Create Envelope key.

Figure 3-2. Limit Envelope
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Setting Up Markers

Press the Marker main menu key to display the Marker menu.

Selecting, Activating, and Placing a Marker

1. Press the Marker 1 2 3 4 5 6 submenu key and then select the desired marker using the 

touch screen marker buttons. The selected marker is underlined on the Marker 

submenu key. 

2. Press the On Off submenu key so that On is underlined. The selected marker is 

displayed in red and ready to be moved.

3. Use the rotary knob to place the marker on the desired frequency.

4. Repeat steps 1 through 3 to activate and move additional markers.

Selecting, Activating, and Placing a Delta Marker:

1. Press the Marker 1 2 3 4 5 6 submenu key and select the desired delta marker. The 

selected marker is underlined.

2. Press the Delta On Off submenu key so that On is underlined. The selected marker is 

displayed in red and ready to be moved.

3. Use the rotary knob to place the delta marker on the desired frequency.

4. Repeat steps 1 through 3 to activate and move additional markers.

Viewing Marker Data in a Table Format

1. Press the More submenu key.

2. Press the Marker Table submenu key so that On is underlined. All marker and delta 

marker data are displayed in a table under the measurement graph.

Figure 3-3. Marker Table
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Select a Measurement Type

In Spectrum Analyzer mode, press Shift then Measure (4) and select a measurement using 

the submenu keys.

Figure 3-4. Spectrum Analyzer Measure Menu
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Chapter 4 — File Management

4-1 Introduction

This chapter will review the file management features of the Spectrum Master and detail the 

File menu. The submenus under this menu allow the user to save, recall, copy, and delete files 

in internal memory or an external USB flash drive.

4-2 Managing Files

Press the Shift key then the File (7) key on the numeric keypad to list the File menu. Follow 

the additional steps below.

Save Files

Set the Save Location 

Press the Save submenu key then the Change Save Location and select the location to save 

files. You can save files to the internal memory or to an external USB flash drive. You can 

also create new folders. If an external USB flash drive is connected or disconnected, press 

Refresh Directories to update the location tree. Press the Set Location key to store the save 

location.

Save Measurement As

The Save Measurement As key is used to quickly save measurements with a specific file 

name. The Spectrum Master saves the measurement with the latest file name that was used 

to save a measurement and with a number that is automatically incremented and appended 

to the end of the file name. For instance, if the last measurement was saved with the name 

ACPR, Save Measurement As saves the next measurement as ACPR_#1, ACPR_#2, etc. The 

file name used can be changed using the Save dialog box (Figure 4-1).

Save a Measurement

Press the Save Measurement key and enter the name for the measurement file. The file type 

will default to measurement and the appropriate extension will be added based on the current 

measurement mode.

Save a Setup 

Press the Save submenu key, type a name for the setup file, confirm that the file type is Setup 

using the Change Type key or the touchscreen and press Enter to save. 

Create a Menu Shortcut for a Setup file 

Press the Recall submenu key to display saved setup files. Locate the setup file to shortcut 

and then press and hold on the file name for a few seconds. Select a location in the shortcut 

grid to save the setup file.

Note
When navigating through the File menu, pressing the Esc key will return to the 

previous menu.
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Save a Measurement Screen as JPEG 

Press the Save submenu key, type a name for the JPEG file, confirm that the file type is Jpeg, 

and press Enter to save.

Save Dialog Box

The save dialog box (Figure 4-1) is used to store files on the internal memory or an external 

flash drive. The file type, file name, and save location are set at this display. See “Save Menu” 

on page 4-8 and “Save Location Menu” on page 4-9 for details. 

Quick Name Keys

Quick Name keys below the keyboard in Figure 4-1 allow users to enter quick names for 

frequently used file measurement names. To edit the keys, press the Shift key, then the 

File (7) key. Press Save then the Change Quick Name key, select one of the Quick Names for 

editing, press Enter and enter the new name for the key. Press Enter again and the new name 

will be displayed on the key. 

Figure 4-1. Save Dialog Box
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Recall Files

The recall menu enables you to view all the Measurement and Setup files in the internal 

memory and external USB flash drive.

You can sort the recall menu by name, date, or type. You can also select to view only 

measurement files or setup files by pressing File Type on the Recall dialog box and selecting 

the file type you want to view.

Recall a Measurement

From the File menu, press the Recall Measurement submenu key, select the measurement 

with the touchscreen, rotary knob or the Up/Down arrow keys and press Enter. 

Recall a Setup

Press the Recall submenu key. Confirm that the file type is Setup or All. Select the setup file 

(.stp) with the touchscreen, rotary knob or the Up/Down arrow keys and press Enter.

Recall Dialog Box 

The Recall dialog box (Figure 4-2) will open previously saved measurements and setups. 

See the “Recall Menu” on page 4-11 for additional information. 

Figure 4-2. Recall Dialog Box
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Copying Files

The steps below detail copying a file from internal memory to an external flash drive. Select 

the files to copy in the top window and the location for the files to be copied to in the bottom 

window (Figure 4-3). Refer to the “Copy Menu” on page 4-12 for additional information.

1. Insert a USB drive into either USB Type A port of the Spectrum Master. 

2. From the File main menu, press the Copy submenu key. The Copy submenu and Copy 

dialog box are displayed.

3. Select the file(s) to copy. To select multiple files, highlight the first then press the Select 

or De-Select key to keep the file selected. The file will be outlined in blue. Repeat with 

all the files to copy. To display files in a folder, select the folder and press the Enter key.

4. Press the Scroll submenu key and highlight the USB drive in the lower window using 

the touch screen or the Up/Down arrow keys. The Scroll submenu key toggles between 

Src (top window) and Dst (bottom window).

5. Press the Copy key to copy the files to the flash drive.

Figure 4-3. Copy Dialog Box
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Deleting Files 

Delete a Selected File or Files 

Press the Delete submenu key. Highlight the file to be deleted with the touchscreen or the 

Up/Down arrow keys. Press the Select or De-Select key. The file will be outlined in blue when 

selected. Press the Delete key and Enter to delete the selected file. 

Delete Dialog Box

Press the Delete submenu key to open the Delete dialog box (Figure 4-4). The submenus allow 

sorting by file type, name and saved date. See the “Delete Menu” on page 4-13 for additional 

information. 

Figure 4-4. Delete Dialog Box
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4-3 File Menu Overview

Open this menu by pressing the Shift key, then the File (7) key. 

Figure 4-5. File Menu
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4-4 File Menu 

Key Sequence: File

Save Measurement As: This key will save the current setup with a user 

defined file name. The default file name is changed using the Save 

submenu. To change the default file name, type in a new file with the touch 

screen keyboard and press Enter. After a few seconds the screen with return 

to File menu. Press the Save Measurement As key again and the new file 

name will be used. Measurement files names have a .spa extension. 

Save Measurement: Press this submenu key to display the “Save Menu” 

on page 4-8 and the touch screen keyboard. Measurements can be saved to 

internal memory or to a USB flash drive. The saved measurement can be 

named by using touch screen keyboard. By default, measurements are 

saved in a directory named /user to internal memory. The save destination is 

set with the “Save Location Menu” on page 4-9.

Save: Press this submenu key to display the “Save Menu” on page 4-8 and 

the touch screen keyboard. Measurements can be saved to internal memory 

or to a USB flash drive. The saved setup, measurement or JPEG file can be 

named by using touch screen keyboard. By default, measurements are 

saved in a directory named /user to internal memory. The save destination is 

set with the “Save Location Menu” on page 4-9.

Save on Event (Spectrum Analyzer mode only): Press this submenu key to 

display the “Save On Event Menu” on page 4-10. 

Recall Measurement: Press this submenu key to display the “Recall Menu” 

on page 4-11. This menu is for recalling measurements from internal memory 

or a USB flash drive.

Recall: Press this submenu key to display the “Recall Menu” on page 4-11. 

This menu is for recalling measurement or setup data from internal memory 

or a USB flash drive.

Copy: Press this submenu key to display the “Copy Menu” on page 4-12. 

This submenu is for copying files or folders from internal memory or a USB 

flash drive.

Delete: Press this submenu key to display the “Delete Menu” on page 4-13 

and a selection box that shows the setup and measurement names, the type 

and the date and time that the information was saved. Use the rotary knob or 

the Up/Down arrow keys to highlight the file that is to be deleted and press 

the Delete submenu key, then Enter. Press the Esc key to cancel the 

operation. Note that deleted files can not be recovered.

Figure 4-6. File Menu
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Save Menu 

Key Sequence: File > Save 

The top keys in the Save menu will display the available save options based 

on the current measurement mode. Options include:

Setup: Setup files contain basic instrument information, 

measurement mode setup details, measurement marker data, and 

limit data. File extension: .stp

Measurement: Contains the measurement data and opens up with 

Master Software Tools. File extension: Varies based on measurement.

Jpeg: Jpeg files contain a screen capture of the display. File 

extension: .jpg

Limit Lines: Contains limit line data details. File extension: .lim

kml: Saves measurement and location data that can be viewed in 

Google Earth. File extension: .kml

Change Quick Name: Press this submenu key to change the Quick Names 

at the bottom of the touch screen keyboard (Figure 4-1). Select the Quick 

Name to edit and press Enter. Type the new Quick Name and press Enter 

again. The new Quick Name will display on the button below the keyboard.

Change Save Location: Press this submenu key to open the 

“Save Location Menu”. 

Figure 4-7. Save Menu
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Save Location Menu 

Key Sequence: File > Save > Change Save Location 

This menu and dialog box is used to create folders and select where the 

Spectrum Master will save the current file. Select folders or drives with the 

Up/Down keys, the rotary knob or the touch screen. 

Note: Only folders (not files) are visible in the Save Location dialog box. To 

view files, use the “Recall Menu” on page 4-11.

Sort By: Press this submenu key to sort the folders by Name, Type, or Date. 

Sort Order: Displays the folder names in ascending or descending order.

Create Folder: This key will create a new folder in the highlighted location 

or folder. The create directory dialog box will display for naming the folder.

Set Location: This key will set the current location for saving files and return 

to the “Save Menu” on page 4-8.

Refresh Directories: Press this key to update the display.

Figure 4-8. Save Location Menu

Figure 4-9. Select Save Location Dialog Box
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Save On Event Menu 

Key Sequence: File > Save On Event 

In Spectrum Analyzer mode, this menu is used to auto save measurements 

to internal memory after:

...Crossing Limit: Toggling this submenu key to On will save the 

measurement to internal memory when the measurement has crossed a 

defined limit line created with the Limit menu.

...Sweep Complete: Toggling this submenu key to On will save the 

measurement to internal memory after the current sweep is complete. If 

Save Then Stop is toggled Off, a measurement will be saved after every 

sweep.

Save Then Stop: Set this key to On to stop the sweep after a 

measurement is saved. With this key Off and Sweep Complete On a 

measurement is saved after every sweep.

Clear All: Pressing this key will turn Off the three save on event keys:

Crossing Limit

Sweep Complete

Save Then Stop 

Figure 4-10. Save On Menu
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Recall Menu 

Key Sequence: File > Recall 

This menu and dialog box is used to navigate folders and select files to 

recall to the Spectrum Master. Select folders or files with the Up/Down 

keys, the rotary knob, or the touch screen. 

Sort By: Press this submenu key to sort file and folders by the file name, 

by the type of file, or by the date that the file or folder was saved.

Sort Order: Displays the folder or file in ascending or descending order 

based on the selection in the Sort By key.

File Type: Press this submenu key to select what type of file is viewed. The 

options are the ALL, Measurement, or Setup. The file type can be changed 

with the Up/Down keys, the rotary knob, or the touch screen. Press Enter 

to make the selection.

Setup: Setup files contain basic instrument information, 

measurement mode setup details, measurement marker data, and 

limit data. 

Measurement: Measurement files contain all of the information in 

the setup files and the measurement data.

Limit Lines (.lim): The Limit line file contains limit line data details.

ALL: Displays all file types.

Refresh Directories: Press this key to update the display.

Figure 4-11. Recall Menu
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Copy Menu 

Key Sequence: File > Copy 

This menu and dialog box is used to copy folders and files. Select folders or 

files with the Up/Down keys, the rotary knob or the touch screen. Figure 4-3 

on page 4-4 shows the Copy dialog box with two JPG images and one 

folder (including the folder’s contents) selected and ready to be copied to 

the USB flash drive. Highlight a folder and press Enter to view the contents.

Sort By: Press this submenu key to sort file and folder lists by name, by 

type of file, or by the date that the file was saved.

Sort Order: Displays the folder or file in ascending or descending order 

based on the selection in the Sort By key.

File Type: Press this submenu key to select what type of file to view for 

copying. The options are: ALL, Measurement, Setup, or JPG. The file type 

can be changed with the Up/Down keys, the rotary knob, or the touch 

screen. Press Enter to make the selection.

Refresh Directories: Press this key to update the display. 

Scroll Scr Dst: Press this submenu key to use the scroll function in the 

Source Folder (Scr - top panel) or Destination Folder (Dst - bottom panel). 

See Figure 4-3.

Select or De-Select: Use this key to select or deselect the file(s) or 

folder(s) to be copied. When selected, a file or folder will be outlined in blue, 

see Figure 4-3.

Copy: Copies the files or folders selected in the top window to the 

destination selected in the bottom window. A dialog box will display showing 

when the copying is complete. If a file with the same name exists in the 

destination folder a warning box will display to allow file overwrite or to 

cancel.

Figure 4-12. Copy Menu
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Delete Menu

Key Sequence: File > Delete 

This menu and dialog box is used to delete folders and files. Select folders 

or files with the Up/Down keys, the rotary knob or the touch screen. 

Sort By: Press this submenu key to sort files and folders by name, by the 

type of file, or by the date that the file or folder was saved.

Sort Order: Displays the folder or file in ascending or descending order 

based on the selection in the Sort By key.

File Type: Press this submenu key to select what type of file view for 

deleting. The options are the ALL, Measurement, Setup, Limit Lines, or 

JPG. The file type can be changed with the Up/Down keys, the rotary knob, 

or the touch screen. Press Enter to make the selection.

Select or De-Select: Use this key to select or deselect the file(s) or 

folder(s) to be deleted. When selected, a file or folder will be outlined in 

blue.

Delete: Press this key to open the Delete dialog box. Press Enter to delete 

the selected item or Esc to Cancel. 

Refresh Directories: Press this key to update the display.

Figure 4-13. Delete Menu
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Chapter 5 — System Operations 

5-1 Introduction

This chapter reviews the Spectrum Master system operations and related menus. The other 

menus (Sweep, Measure, Trace, and Limit) are described in the Measurement Guides that 

are listed in Appendix A.

www.valuetronics.com



5-2 System Menu Overview System Operations 

5-2 PN: 10580-00328  Rev. H Spectrum Master User Guide

5-2 System Menu Overview 

To access the functions under the System menu, select the Shift key, then the System (8) key. 

Figure 5-1. System Menu

GPS

Back

GPS

On               Off

GPS Voltage

3.3 V             5 V

GPS Info

Reset

System

System

Options

Application

Options

GPS

Status

Self

Test

Application

Self

Test

Calibrate

Touch

Screen

Reset

System Options

Date

&

Time

Language

Name

Volume

More

Display

Back

Reset

Factory

Defaults

Master

Reset

Update

Firmware

1

1

Back

Display Settings

Brightness

Default Colors

Black & White

Night Vision

High Contrast

2

Back

System Options 2/2

Share CF &

Pwr Offset

All Modes  Not Shared

Set

Remote Access

Password

2

www.valuetronics.com



System Operations 5-3 System Menu

Spectrum Master User Guide PN: 10580-00328  Rev. H 5-3

5-3 System Menu 

Key Sequence: Shift, System (8) 

Status: Pressing this submenu key displays the current system status, 

including the operating system and firmware versions, temperatures and 

other details such as current battery information. Press Esc or Enter to 

return to normal operation.

Self Test: This key initiates a series of diagnostic tests that check the 

components of the instrument. A display will list the individual tests with a 

pass or fail indication. Press Esc or Enter to return to normal operation.

Application Self Test: This key initiates a series of diagnostic tests related 

to the performance of the instrument for specific applications. A display will 

list the individual tests with a pass or fail indication. Press Esc or Enter to 

return to normal operation.

GPS: Opens the “GPS Menu” on page 6-4.

Calibrate Touch Screen: Start the touch screen calibration. Run the 

calibration procedure when instrument is not responding to your screen taps 

as expected.

Application Options: This submenu key presents a menu to select 

application options. This will vary depending upon the measurement mode.

System Options: This key opens the “System Options Menu” on page 5-4.

Figure 5-2. System Menu
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System Options Menu 

Key Sequence: Shift, System (8) > System Options 

Date and Time: This key brings up a dialog box for setting the current date 

and time. Use the submenu keys or the Left/Right arrow keys to select the 

field to be modified. Use the keypad, the Up/Down arrow keys or the rotary 

knob to select the date and time. Press Enter to accept the changes, or 

press the Esc key to return to normal operation without changing anything.

Language: This submenu key brings up a selection box allowing selection 

from a list of built-in languages for the Spectrum Master displays. The 

languages currently available are English, French, German, Spanish, 

Japanese, Chinese, Korean, and Italian. In addition, up to two custom 

languages may be loaded into the instrument if they have been defined using 

the Master Software Tools. If a mode does not have language translations 

available, English is the default language. Press Enter to accept the change, 

or press the Esc key to return to normal operation without changing the 

setting.

Display: The Display submenu key opens the “Display Settings Menu” 

on page 5-6 allowing brightness control and the selection of the default color 

display, black & white display, night vision display, or a high contrast display.

Name: Opens a dialog box to name the instrument. The unit can be named 

using the keypad to select numbers and the touch screen keys to select letter 

groups. Use the Shift key to select an upper case letter. Use the Left/Right 

directional arrows to move the cursor position. The Back Space key will 

remove the last character entered. Press Enter to save the name.

Volume: The current volume setting is displayed on the screen. Use the 

keypad, the Up/Down arrow keys or the rotary knob to change the volume 

and press the Enter key to accept the change.

Reset: Press this submenu key to open the “Reset Menu” on page 5-7.

More: Press this submenu key to open the “System Options 2/2 Menu” 

on page 5-5.

Figure 5-3. System Options Menu
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System Options 2/2 Menu 

Key Sequence: Shift, System (8) > System Options > More 

Remote Access Password       

This function is valid only with Master Software Tools (MST) v2.21.1 or later. After setting 

the password, reboot the instrument (normal power OFF then ON) to provide remote access 

security. Only one user then has access at any one time. 

The password is first set into the instrument, then used in MST. When prompted in MST, 

enter the password into the password text box. The password text box shown in Figure 5-5 

may differ from the text box that is displayed on your instrument. 

The password can be removed or reset by a Master Reset, by a Factory Default reset, or by a 

firmware update (which includes a restart).

Center Freq Share: Select All Modes to have the current center frequency 

setting carried over when changing measurement modes. This feature is not 

applicable to measurements which do not have a center frequency setting or 

to measurements in which the current center frequency setting is outside the 

range of the new measurement. 

Set Remote Access Password: Press this submenu key to open the 

Password text box (Figure 5-5) and Text Entry menu. Type in the desired 

password. Upper case and lower case letters and the symbols - _ + . 

are the allowed password characters. Press Enter to save or Esc to cancel.

Back: Press this submenu key to return to the “System Options Menu” 

on page 5-4.

Figure 5-4. System Options Menu
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Display Settings Menu 

Key Sequence: Shift, System (8) > System Options > Display 

Brightness: The brightness of the display can be adjusted to optimize 

viewing under a wide variety of lighting conditions. Use the keypad, the 

Up/Down arrow keys or the rotary knob to select a brightness level from 1 to 

9, with 9 being the brightest. Press Enter to accept the change.

Default Colors: Sets the display colors to their factory default condition. 

Used for normal viewing.

Black & White: Sets the display colors to black and white. Used for printing 

and viewing in broad daylight conditions.

Night Vision: Sets the display to a red-tinted color. Optimized for night-time 

viewing.

High Contrast: Increases the contrast of the default display colors. Used for 

other challenging viewing conditions.

Back: Press this submenu key to return to the “System Options Menu” 

on page 5-4.

Figure 5-6. Display Settings Menu
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Reset Menu 

Key Sequence: Shift, System (8) > System Options > Reset 

Factory Defaults: Restores the instrument to the factory default values, 

including Ethernet (Option 411), language, volume, brightness setting, and 

user created shortcut icons on the Menu screen. Press the Enter key to 

initiate the reset, and power-cycle the instrument.

Master Reset: In addition to the functions described in Factory Defaults 

above, all user files in the internal memory are deleted, and the original 

language and antenna files are restored. Press the Enter key to initiate the 

Master Reset and power-cycle the instrument. Press Esc to return to normal 

operation without resetting.

Update Firmware: Press this submenu key to update the instrument 

operating system with a USB memory device. Press Enter and follow the 

onscreen instructions to update the firmware or press Esc to return to normal 

operation without updating. Refer to “Updating the Spectrum Master 

Firmware” on page 5-9 for additional information on both firmware update 

options.

Back: Press this submenu key to return to the “System Options Menu” 

on page 5-4.

Figure 5-7. Reset Menu
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5-4 Preset Menu

Key Sequence: Shift, Preset (1) 

5-5 Self Test 

At power on, the Spectrum Master runs through a series of quick checks to ensure that the 

system is functioning properly. The System self test runs a series of tests that are related to 

the instrument. The Application Self Test runs a series of tests that are related to the current 

operating mode of the instrument. 

If the Spectrum Master is within the specified operating range with a charged battery and the 

self test fails, contact your Anritsu Service Center at http://www.anritsu.com/contact-us.

To start a self test when the system is already powered up:

1. Press the Shift key and then the System (8) key.

2. Press the Self Test submenu key. The Self Test results are displayed. 

3. Press Esc to continue.

Preset: This key resets the instrument to the default starting conditions.

Save Setup: Opens the Save dialog box (Figure 4-1) to name and save 

the current operating settings, allowing them to be recalled later to return 

the instrument to the state it was in at the time the setup was saved. 

The saved setup can be named using the touch screen keyboard. Use the 

Caps key to select an upper case letter. Use the Left/Right directional 

arrows to move the cursor position. Press Enter to save the setup.

Note: Set the File type as Setup. See “Save Menu” on page 4-8 for details.

Recall Setup: This key allows the selection and recall of a previously 

stored instrument setup using the “Recall Menu” on page 4-11. Use the 

rotary knob, the Up/Down arrow keys, or the touchscreen to highlight the 

saved setup, and press Enter. All current instrument settings are replaced 

by the stored setup information. 

Figure 5-8. Preset Menu

Recall

Setup

Preset

Save

Setup

Preset

www.valuetronics.com

http://www.anritsu.com/contact-us


System Operations 5-6 Updating the Spectrum Master Firmware

Spectrum Master User Guide PN: 10580-00328  Rev. H 5-9

5-6 Updating the Spectrum Master Firmware 

The Spectrum Master is updated using a USB memory stick. Updated product information 

can be found on the Anritsu website:

http://www.anritsu.com/

Search for the product model number. The firmware updates are on the product page under 

the Library tab in the “Drivers, Software Downloads” section.    

1. Click on the “Firmware Update for the Spectrum Master MS2711E” link.

2. Click the “Download” button and then “Run”. After the download is complete, press 

“Run” again and follow the onscreen instructions. Press “Help (?)” for additional 

information.

3. After the firmware update is saved on the USB memory stick, eject the memory stick 

from the computer. 

4. Turn the Spectrum Master off and insert the USB memory stick into the 

Spectrum Master.

5. Connect the AC adapter and turn the Spectrum Master On.

6.  The instrument should update automatically. Follow the instrument prompts. 

7. If the automatic update did not start, complete the following steps:

a. On the instrument, press the Shift key and then the System (8) key. 

b. Press the following key sequence: System Options > Reset > Update Firmware. 

The Load Firmware menu opens.

c. Press the Load Firmware main menu key (located at the bottom-left corner of the 

instrument screen).  

d. Press the Update Application Firmware submenu key. 

e. From the choices presented, select the desired “Save” mode. 

f. Press the Enter key to begin the firmware update. 

g. Press the Enter key one more time to confirm that you want to upgrade the 

instrument firmware.

8. After the update is compete, the Spectrum Master will restart.

Note The “Release History” link provides a summary of the firmware changes.

Note
Do not turn off the instrument during the firmware update to avoid potential 

permanent damage to the instrument. 
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Chapter 6 — GPS (Option 31)

6-1 Introduction

The Spectrum Master is available with a built-in GPS receiver feature (Option 31) that can 

provide latitude, longitude, altitude, and UTC timing information. This option also enhances 

frequency reference oscillator accuracy in the spectrum analyzer mode. Within three minutes 

of satellite acquisition, the reference oscillator will have an accuracy of better than 25 ppb 

(parts per billion). No accuracy specifications apply if no GPS satellites are acquired. 

In order to acquire data from the GPS satellites, the user must have line-of-sight to the 

satellites or the antenna must be placed outside without any obstructions. An Anritsu GPS 

antenna is required.

6-2 Activating the GPS Feature

Install the Anritsu GPS antenna onto the GPS Antenna connector on the Spectrum Master.

1. Press the Shift key, then the System (8) key.

2. Press the GPS submenu key.

3. Press the GPS On/Off submenu key to toggle the GPS feature on or off. When GPS is 

first turned on, a RED GPS icon will be appear at the top of the display.

Note
The Spectrum Master Technical Data Sheet provides a list of the options and 

measurements that require GPS (Option 31).

Figure 6-1. GPS Icon, Red

GPS
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4. When the GPS receiver has tracked at least three satellites, the GPS icon will change to 

GREEN. Latitude and Longitude information is displayed in the white bar on top of the 

display. Acquiring satellites may take as long as three minutes. 

5. Press the GPS Info submenu key to view information about: 

� Tracked Satellites

� Latitude and Longitude

� Altitude

� UTC

� Fix Available

� Almanac Complete

� Antenna and Receiver Status

� GPS Voltage and Current

See Section 6-4 “GPS Menu” on page 6-4 for details about the GPS Info dialog box.

6. Press the Reset submenu key to reset the GPS.

7. The GREEN GPS icon with a RED CROSS through it, as shown below, appears when 

GPS satellite tracking is lost (after actively tracking 3 or more satellites). The GPS 

longitude and latitude are saved in the instrument memory until the Spectrum Master 

is turned off or until GPS is turned off by using the GPS On/Off key.

Figure 6-2. GPS Icon, Green

Figure 6-3. GPS Icon, Tracking Lost

GPS

GPS
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6-3 Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information

The GPS coordinates of a location can be saved along with a measurement trace. Refer to the 

“Save Menu” on page 4-8 for more information. The current GPS coordinates will be saved 

with the measurement traces whenever GPS is on and actively tracking satellites.

Recalling GPS Information

If the GPS coordinates were saved with a measurement, then when the measurement is 

recalled, the coordinates that were saved are recalled as well. Refer to the “Recall Menu” 

on page 4-11 for more information about recalling a saved trace.
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6-4 GPS Menu 

Key Sequence: Shift, System (8) > GPS 

GPS: Press this submenu key to turn GPS on or off.

GPS Info: Press this submenu key to display the current GPS information.

Tracked Satellites: Shows the number of tracked satellites (three are 

required to retrieve latitude and longitude, four are required to resolve 

altitude). Generally, the larger number of satellites tracked, the more 

accurate the information.

Latitude and Longitude: Shows location in degrees, minutes, and 

seconds.

Altitude: Shows altitude information in meters.

UTC: Universal Coordinated Time.

Fix Available: The cold start search sets are established to ensure 

that at least three satellites are acquired within the first couple of 

minutes. When three satellites are found, the receiver will compute an 

initial fix (typically in less than two minutes). Fix Not Available means 

that the initial position has not been established.

Almanac Complete: The system Almanac contains information 

about the satellites in the constellation, ionospheric data, and special 

system messages. In a cold start, the GPS receiver does not have any 

navigation data so the receiver does not have a current almanac. A 

complete system almanac is not required to achieve a first position fix. 

The availability of the almanac, however, can significantly reduce the 

time to first fix.

Antenna Status:

OK: Antenna is connected properly and antenna is working properly

Short/Open: A short or open exists between the antenna and the 

connection. If this message is displayed, then remove and replace the 

GPS antenna. If the message persists, then try another Anritsu GPS 

antenna. If the message persists, contact your nearest Anritsu Service 

Center.

Receiver Status: Current status of the receiver.

GPS Antenna Voltage and Current: Shows voltage and current.

GPS Voltage: Press this submenu key to set the source voltage to be either 

3.3 V or 5 V depending on the GPS receiver being used. GPS antenna 

voltage is set to 3.3 V by default in order to prevent accidental damage to 

lower-voltage GPS antennas.

Reset: The Reset key sets the tracked number of satellites to 0 and erases 

any almanac data, along with saved coordinates. The process of searching 

for and reacquiring satellites will begin again.

Back: Press this submenu key to return to the “System Menu” on page 5-3.

Figure 6-4. GPS Menu

GPS

Back

GPS

On               Off

GPS Voltage

3.3 V             5 V

GPS Info

Reset
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Chapter 7 — Anritsu Tool Box

7-1 Introduction

The Anritsu Tool Box is a suite of applications that provide an interface between Anritsu 

handheld RF instruments and a PC. The instrument connects to the computer via a USB, 

Ethernet, or serial port. Depending on the application selected, available functions include 

the capture, transfer, and reporting of measurement data for trace analysis and RF 

interference analysis.

The Tool Box may be installed from the Anritsu software DVD or you can download 

individual applications from the Anritsu website at 

www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx

This chapter gives an overview of the software installation DVD and the main features of 

each application in the Anritsu Tool Box.

7-2 Software Installation DVD

Place the software disc in the DVD drive on your PC and follow the on-screen instructions. 

The Setup Wizard welcome screen illustrated in Figure 7-1 may change with the software 

version.

You will be asked to select which applications you wish to install. Not all instrument models 

are supported by every software tool. Visit the web page referenced in the Introduction 

section above and follow the links for more information on a specific tool. 

Figure 7-1. Anritsu Tool Box Setup Wizard
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If the installer does not autostart, open the DVD in Windows Explorer and double-click the 

executable setup file. See Figure 7-2. 

7-3 Anritsu Software Tool Box

The Anritsu Tool Box serves as a central location from which you can open a previously saved 

measurement, visit the Anritsu website, or launch an application. To open the Tool Box, 

either double-click the desktop shortcut or select the Tool Box from the Windows Start menu, 

under All Programs and the Anritsu folder. On the Tool Box screen, hover the mouse pointer 

over any of the application icons to view a short description of the application. See Figure 7-3. 

Figure 7-2. Tool Box Installer on the Anritsu Software DVD

Figure 7-3. Anritsu Tool Box Screen
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7-4 Software Tools

The Anritsu Tool Box provides links to the software tools installed on your PC. Alternatively, 

you can launch an application using its desktop shortcut or through the Windows Start menu.

The following sections list the top features and functions of the tools contained in the Anritsu 

Tool Box that are compatible with the Spectrum Master MS2711E. For a detailed description 

of these features and how to perform specific tasks, refer to each application’s Help system. 

The program Help also lists the instrument models, measurement modes, trace types, and file 

types that are compatible with that application.

Line Sweep Tools (LST)

Line Sweep Tools is post-capture trace processing software designed for users who need to 

analyze and generate reports on large numbers of cable, antenna, and PIM traces. Software 

features include:

� Measurement plot data capture and transfer from the instrument to a PC

� Marker and limit line presets

� Return Loss, Distance-to-Fault, PIM analysis

� LMR Master and VNA Master Field Mode compatibility

� Plot overlay for comparison of up to ten traces of the same measurement type

� Plot area zooming

� A naming grid for renaming files, titles, and subtitles

� Automated report generation

� Output to printer or to PDF or HTML format

� Export of plot data to text, image, or VNA files

Master Software Tools (MST)

Master Software Tools is designed for users of Anritsu handheld spectrum analyzers, 

interference analysis tools, transmission testers, and backhaul testers. Supported functions 

include the following:

� Transfer of captured measurement data to and from a PC for storage and analysis

� RF Spectrum Analyzer traces

� RF Interference analysis

� Spectrum monitoring

� Transmitter signal quality tests

� T1, T3, and E1 backhaul tests

� Trace overlay features for comparing multiple Spectrum Analyzer measurements

� Limit lines and markers

� Script Master for the creation of automated test procedures

� Export of measurement data as text, graphic, or Comma Separated Value format (CSV) 
files

� Reports created in HTML format for use in other applications
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Appendix A — Measurement Guides

A-1 Introduction 

This appendix provides a list of supplemental documentation for Spectrum Master features 

and options. These measurement guides are available as PDF files on the documentation disc 

and the Anritsu website.

A complete suite of computer software applications are available for download:

http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx 

Table A-1. Analyzers and Analyzer Options

Spectrum Master Feature (Required Option)

Related Document 

(Part Number)

All Spectrum Master Instruments

Important Product 

Information, Compliance 

and Safety Notices

(10100-00065)

Spectrum Analyzer

Preamplifier (Option 8)

Interference Analyzer (Option 25)

Channel Scanner (Option 27)

EMF Measurements (Option 444)

AM/FM/PM Analyzer (Option 509)

Spectrum Analyzer 

Measurement Guide 

(10580-00244) 

High-Accuracy Power Meter (0019)

Power Meter (Option 29)

Power Meter 

Measurement Guide 

(10580-00240)

Performance Specifications Spectrum Master 

Technical Data Sheet 

(11410-00597)

Tracking Generator (Option 20) E-Series Tracking 

Generator 

Measurement Guide

(10580-00339)

SCPI Programming Instruction Spectrum Master 

Programming Manual 

(10580-00256)

Maintenance Manual Spectrum Master 

Maintenance Manual 

(10580-00254)

Documentation

Handheld Instruments 

Documentation Disc

(10920-00060)
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Anritsu Company
490 Jarvis Drive

Morgan Hill, CA 95037-2809
USA

http://www.anritsu.com

 Anritsu utilizes recycled paper and environmentally conscious inks and toner.
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